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1  PREFACE

Mari is a creative texture-painting tool that can handle extremely complex 
or texture heavy projects. It was developed at Weta Digital and has been 
used on films such as The Adventures of Tintin: The Secret of the Unicorn, 
District 9, The Day the Earth Stood Still, The Lovely Bones and Avatar.

The name Mari comes from the Swahili 'Maridadi', meaning 'beautiful' and 
carrying connotations of 'usefulness'.

About This Guide This guide provides you with the basic information you need to start 
painting with Mari.

The first part of the manual, Installation and Licensing describes how to 
install, license, and launch Mari.

The rest of the manual consists of a few short chapters describing Mari’s 
basic functionality and five tutorials which teach you the basics of creating 
a Mari project and painting textures. The tutorials provide a series of 
comprehensive walk-throughs, complete with geometries and associated 
textures. As you follow the steps in these tutorials, you'll gain a good feel 
for Mari's user interface and workflow. This, in turn, provides a good 
working knowledge for creating more complex production projects.

For more detailed information on Mari and its functions, see the 
accompanying Mari User Guide and Mari Reference Guide.

Contact 
Customer 
Support

Should questions arise that this manual fails to address, you can contact 
Customer Support directly via e-mail at support@thefoundry.co.uk or via 
telephone to our London office on +44 (0)20 7968 6828 or to our Los 
Angeles office on (310) 399 4555 during office hours.



2  INSTALLATION AND LICENSING

Steps for 
Running Mari

To run Mari, follow these steps:

1. Check the System Requirements

2. Install Mari

3. Launch Mari

4. License Mari

System 
Requirements

Officially supported operating systems

• Windows 7 64-bit, or a Linux 64-bit operating system (Fedora 12 or Red 
Hat Enterprise Linux 5.4)

Minimum hardware requirements

• Quad-core processor

• 250GB disk space available for caching and temporary files (or a 
minimum of 50GB if you're working on a small project)

• At least 4GB RAM

• Display with 1680 x 1050 pixel resolution

• An NVIDIA or AMD graphics card with at least 1GB of RAM and OpenGL 
3.2 support (see Tested graphics cards below)

Virtual memory requirements

It is recommended that the system running Mari has plenty of virtual 
memory available to use, especially when handling large projects. The use of 
virtual memory improves stability, helping to prevent data loss on large 
projects.

NOTE: Some newer Linux distributions have changed their network device 
configuration handling and won’t work with Mari without some 
configuration changes. Known affected distributions at this time include 
Fedora 16, Red Hat Enterprise Linux 6, and CentOS 6 on certain, notably 
Dell, hardware. Please see our FAQs for more information: http://
www.thefoundry.co.uk/support/faqs/#question_97

http://www.thefoundry.co.uk/support/faqs/#question_97
http://www.thefoundry.co.uk/support/faqs/#question_97
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Tested graphics cards

• NVIDIA GeForce GTX 480

• NVIDIA GeForce GTX 580

• NVIDIA GeForce GTX 680

• NVIDIA Quadro (Fermi Series) 4000

• NVIDIA Quadro (Fermi Series) 5000

• NVIDIA Quadro (Fermi Series) 6000

• AMD FirePro W7000

• AMD FirePro W8000

• AMD FirePro W9000

• AMD Radeon HD 7850

• AMD Radeon HD 7950

Please download and install the latest graphics driver for your card from the 
NVIDIA or AMD websites.

Install Mari Mari 2.0 is available to download from our web site at 
www.thefoundry.co.uk/mari. The downloads are in a compressed format 
(.run or .exe).

On Linux 1. Download the .run installation file from our web site at www.the-
foundry.co.uk/mari.

2. Extract Mari from the .run archive with the following terminal command, 
replacing [version number] with the current version: 

sudo ./Mari[version number]-linux-x86-release-64.run

The installer displays the End User Licensing Agreement (EULA) and 
prompts you to accept it.

3. If you agree with the EULA, enter y and press Return to accept the 
EULA. (If you don’t agree with the EULA and press n instead, the 
installation is canceled.)

By default, Mari is installed in an appropriately named folder in the cur-
rent working directory.

NOTE: Ensure that you are using 8.982.8.1 (AMD Catalyst 12.10) drivers 
or higher for AMD cards.
Mari 2.0v1The Foundry
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4. That's it! Proceed to Launch Mari.

On Windows 1. Download the .exe installation file from our web site at www.the-
foundry.co.uk/mari.

2. Double-click on the installation file to start the installation. Follow the 
on-screen instructions. By default, Mari is installed to 
drive letter:\Program Files\Mari [version number].

3. That's it! Proceed to Launch Mari.

NOTE: If you leave out sudo from the terminal command, you need to 
ensure that you have sufficient permissions to install Mari under your 
current working directory or selected target directory.

After the Mari application files have been installed, the installer also runs 
a post-installation script that creates the following directory:

/usr/local/foundry/RLM

If you don’t have sufficient permissions on the /usr/local folder for this 
directory to be created, the post-installation script prompts you for your 
sudo password as necessary.

TIP: You can also use the following options after the terminal command 
when installing Mari:

•   --info

This lets you see what the default installation directory is.

•   -- target MyMariDirectory

This lets you specify a different directory to install Mari to (in this 
case, MyMariDirectory).

•   --accept-eula

This lets you automate the installation so that you are not prompted 
to accept the EULA. Note that if you use this option, you agree to the 
terms of the EULA. To see the EULA, please refer to Appendix D in the 
Mari User Guide.

•   -- help

This lets you see additional help and installer options.

Here’s an example of the syntax using the --accept-eula option:

sudo ./Mari[version number]-linux-x86-release-64.run --accept-eula
Mari 2.0v1The Foundry
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Installing Mari from the command line

To install Mari from the command line, do the following:

1. Download the correct .exe installation file from our web site at 
www.thefoundry.co.uk. 

2. To open a command prompt window, select Start > All Programs > 
Accessories > Command Prompt.

3. Use the cd (change directory) command to move to the directory where 
you saved the installation file. For example, if you saved the installation 
file in C:\Temp, use the following command and press Return: 
cd \Temp

4. To install Mari, do one of the following:

• To install Mari and display the installation dialog, type the name of the 
install file without the file extension and press Return:
Mari2.0v1-win-x86-release-64 

• To install Mari to a specified directory and display the installation dia-
log, use the /dir install option:

Mari2.0v1-win-x86-release-64 /dir="E:\Mari"

• To install Mari silently so that the installer does not prompt you for 
anything but displays a progress bar, enter /silent after the installa-
tion command:
Mari2.0v1-win-x86-release-64 /silent

• To install Mari silently so that nothing is displayed, enter /verysilent 
after the installation command:
Mari2.0v1-win-x86-release-64 /verysilent

• You can also use a combination of install options:

Mari2.0v1-win-x86-release-64 /silent /dir="E:\Mari"

Launch Mari

On Linux 1. Open a terminal. 

2. Navigate to the directory you installed Mari to. 

3. Enter ./mari.

NOTE: By running a silent install of Mari, you agree to the terms of the 
EULA. To see this agreement, please refer to Appendix D: End User 
Licensing Agreement in the Mari User Guide or run the installer in 
standard non-silent mode.
Mari 2.0v1The Foundry
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4. If you haven’t installed a license for Mari, you need to License Mari. 
Once you’ve done so, click Launch in the Mari Licensing dialog.

Mari checks for Tested graphics cards, and if an untested graphics card 
configuration is detected, a dialog displays warning you about it. 
Depending on the configuration detected, you have the option to Quit or 
Continue and, in the case of configurations with known issues, also 
Ignore Permanently. Note that if you ignore the warning and run Mari 
anyway, you may experience instability or performance issues. If a 
tested graphics card configuration is detected, Mari runs as normal.

5. If you are launching Mari for the first time, you are prompted to choose 
a directory for its cache files. In the Please Pick Cache Directory dialog, 
navigate to the directory you want to use and click Choose.

Note that the cache directory should be: 

• empty

• local to the machine (not a network mount)

• as fast as possible

• a location that's not temporary (to avoid the data disappearing)

• a directory that the user has read and write permissions to.

The Mari graphical interface displays.

Project cache locations are directories that Mari uses to store project data 
files. These directories must be persistent; not in temporary locations. If 
more than one cache location is specified, Mari spreads each project’s data 
files across all locations. Once a project has been created for a given set of 
cache locations, that set must not be changed. In order to move a project 
between different sets of caches, archive the project.

WARNING: Don’t add, remove, or amend cache locations once they have 
been set unless they are empty. Once projects have been created for a 
given set of cache locations, that set must not be changed or project 
corruption will occur.

NOTE: If the MARI_CACHE environment variable has been set, its value is 
used to determine the location of the cache files. In this case, Mari does 
not prompt you to choose the cache directory. For more information on 
environment variables that Mari understands, please refer to the Mari 
User Guide.
Mari 2.0v1The Foundry
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On Windows 1. Click Start > All Programs > The Foundry > Mari 2.0v1 > Mari 2.0v1.

2. If you haven’t installed a license for Mari, you need to License Mari. 
Once you’ve done so, click Launch in the Mari Licensing dialog.

Mari checks for Tested graphics cards, and if an untested graphics card 
configuration is detected, a dialog displays warning you about it. 
Depending on the configuration detected, you have the option to Quit or 
Continue and, in the case of configurations with known issues, also 
Ignore Permanently. Note that if you ignore the warning and run Mari 
anyway, you may experience instability or performance issues. If a 
tested graphics card configuration is detected, Mari runs as normal.

3. If you are launching Mari for the first time, you are prompted to choose 
a directory for its cache files. In the Please Pick Cache Directory dialog, 
navigate to the directory you want to use and click Choose.

Note that the cache directory should be: 

• empty

• local to the machine (not a network mount)

• as fast as possible

• a location that's not temporary (to avoid the data disappearing)

• a directory that the user has read and write permissions to.

The Mari graphical interface displays.

Project cache locations are directories that Mari uses to store project data 
files. These directories must be persistent; not in temporary locations. If 
more than one cache location is specified, Mari spreads each project’s data 
files across all locations. Once a project has been created for a given set of 
cache locations, that set must not be changed. In order to move a project 
between different sets of caches, archive the project.

TIP: You can also launch Mari in verbose mode by using the following 
command:

./mari --verbose

This way, Mari provides a running log of each action that it performs. You 
can see this log in a terminal window.

WARNING: Do not add, remove, or amend cache locations once they have 
been set unless they are empty. Once projects have been created for a 
given set of cache locations, that set must not be changed or project 
corruption will occur.
Mari 2.0v1The Foundry
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License Mari

About Licenses If you simply want to try out Mari, you can obtain a trial license, which 
allows you to run Mari for free for 15 days. See Install the License on 
page 15.

To use Mari after this trial period, you need either a valid activation key or 
a floating license and server running the Foundry Licensing Tools (FLT):

• Activation Keys — These can be used to easily install and activate node 
locked (also known as uncounted) licenses. Node locked licenses allow 
you to use Mari on a single machine. This license does not work on a 
different machine and if you need it to, you’ll have to transfer your 
license. Node locked licenses do not require additional licensing software 
to be installed. See Licensing Mari on a Single Machine for more 
information.

• Floating Licenses — Also known as counted licenses, enable applications 
to work on any networked client machine. The floating license should be 
put on the server and is locked to a unique number on that server. 
Floating licenses on a server require additional software to be installed. 
This software manages those licenses on the server, giving licenses out 
to client stations that want them. The software you need to manage 
these licenses is called the Foundry License Tools (FLT) which can be 
freely downloaded from our web site. Floating licenses often declare a 
port number on the server line and a port number on the vendor line. See 
Licensing Mari over a Network for more information.

The instructions below run through both licensing methods and you can find 
a more detailed description in the Foundry Licensing Tools User Guide 

NOTE: If the MARI_CACHE environment variable has been set, its value is 
used to determine the location of the cache files. In this case, Mari does 
not prompt you to choose the cache directory. For more information on 
environment variables that Mari understands, please refer to the Mari 
User Guide.

TIP: You can also launch Mari in verbose mode by selecting Start > All 
Programs > Mari 2.0v1 > Mari 2.0v1 (Verbose Output). This way, Mari 
provides a running log of each action that it performs. You can see this 
log in a command line window.
Mari 2.0v1The Foundry
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Licensing Mari on a Single Machine 
available on our website: 
http://www.thefoundry.co.uk/support/licensing/tools/

Licensing Mari 
on a Single 
Machine

Obtain an Activation 
Key

You can purchase activation keys over the Internet by clicking Purchase 
License in the Mari licensing dialog that displays when you launch Mari 
without a license, or by contacting The Foundry Sales Department at 
sales@thefoundry.co.uk.

Install the License You are prompted to enter your activation key when you start Mari without 
a license. Mari skips this step if you’ve already activated the application.

Select an activation option from the Mari Licensing dialog:

• Purchase License — Click to open a web browser directly to The Foundry 
website to purchase an activation key.

• Activate Key or Use Server — Click to enter a previously obtained 
activation key. When you enter the activation key, Mari automatically 
obtains a license from the web and installs it on your machine. You’re 
good to go.

• Obtain Trial License — Click to automatically install a trial license valid 
for 15 days. Whenever you then launch Mari, the Mari Licensing dialog 
displays how many days remain before you trial license expires. Note 
that you can only obtain a trial license for a major Mari release once on 
Mari 2.0v1The Foundry
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Licensing Mari over a Network 
each machine (for example, if you had a trial license for Mari 1.1v1, you 
can’t get another one for Mari 1.1v2 on the same machine). 

Licensing Mari 
over a Network

Obtain Floating 
Licenses

Alternatively, you can purchase a floating license key from our website.
To generate a license key, we need to know your System ID. The System ID 
(sometimes called Host ID or rlmhostid) returns a unique number for your 
computer. We lock our license keys to the System ID. See Install Floating 
Licenses.

To display your system ID:

On Windows

1. Do one of the following:

• Download the Foundry License Installer for Mari (FLU) utility from 
http://www.thefoundry.co.uk/support/licensing/tools/ and run it. Your 
System ID is displayed.

• Download the Foundry Licensing Tools (FLT) free of charge from our 
web site and run C:\Program Files (x86)\The 
Foundry\LicensingTools7.0\FoundryLicenseUtility.exe.

NOTE: If you access the Internet through a proxy server and Mari cannot 
connect to the activation server, you may get an error dialog prompting 
you to either:

•   Click Use Proxy to enter the proxy server name, port number, user-
name, and password. This enables Mari to connect to the activation 
server and obtain a license. Mari then installs the license automati-
cally.

•   Click on the web link in the dialog and use the System ID (also known as 
hostid) provided to manually activate and install a license. For more 
information on how to install a license manually, see the Foundry 
Licensing Tools (FLT) User Guide available on our website at http://
www.thefoundry.co.uk/support/licensing/

TIP: If you later want to check the current status of your license (for 
example, to see if it’s a node locked license or a floating license), select 
Tools > License in Mari to display the Mari Licensing dialog.
Mari 2.0v1The Foundry
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2. Once you have provided us with your System ID number and a license 
key has been generated for you, you will receive the license key in an e-
mail or Internet download. The license key is contained in a text file 
called foundry.lic. For information on what to do with the foundry.lic file, 
see Install Floating Licenses below.

On Linux

1. Download the Foundry Licensing Tools (FLT) free of charge from http://
www.thefoundry.co.uk/support/licensing/tools/ and run the following 
command in a terminal shell: 

/usr/local/foundry/LicensingTools7.0/FoundryLicenseUtility

2. Once you have provided us with your System ID number and a license 
key has been generated for you, you will receive the license key in an e-
mail or Internet download. The license key is contained in a text file 
called foundry.lic. For information on what to do with the foundry.lic file, 
see Install Floating Licenses below.

Just so you know what a System ID number looks like, here’s an example: 
000ea641d7a1.

Install Floating 
Licenses

If you requested a floating license from The Foundry, you will receive your 
license key (foundry_float.lic) in an e-mail or Internet download. You should 
also receive the Foundry License Utility (FLU) application to help you install 
the license key. The FLU is also available to download from 
www.thefoundry.co.uk/licensing. The instructions below tell you what to do 
with these.

1. Make sure you have saved both the license key (foundry.lic) and the 
Foundry License Utility application in the same directory.

2. Run the Foundry License Utility application. The license key should 
automatically display in the FLU window if the FLU and foundry_float.lic 
are in the same directory. If they are not, you can either copy and paste 
the contents of the license key or drag and drop the file into the FLU 
window.

3. Click Install. 

This checks the license file and, provided that the license is valid, 
installs it into the correct directory.

In order for the floating license to work, you need to install the Foundry 
Licensing Tools (FLT) on the license server machine. For more informa-
tion on how to install floating licenses, refer to the FLT user guide, 
which you can download from our web site: 
http://www.thefoundry.co.uk/support/licensing/tools/.
Mari 2.0v1The Foundry
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4. Once your license server is up and running, launch Mari (if it isn’t 
already running).

5. Click Activate Key or Use Server and enter the server address in the field 
provided. The format for the server name is <port>@<servername>, for 
example, 30001@red.

Further Reading For more information on licensing Mari, displaying the System ID number, 
setting up a floating license server, adding new license keys and managing 
license usage across a network, you should read the Foundry Licensing 
Tools User Guide available on our web site.

NOTE: You must perform steps 4 and 5 on each client machine that 
requires a Mari license from the server.

TIP: If you later need to display the Mari Licensing dialog again, you can 
select Tools > License in Mari.

TIP: If you need assistance with any of these steps, e-mail 
support@thefoundry.co.uk.
Mari 2.0v1The Foundry



3  MARI MODEL REQUIREMENTS

Model 
Requirements

Mari requires your model files to be configured in a particular way. 

Please bear in mind that Mari allows you to import and paint models with 
Overlapping UVs, like the one shown below. However, if you paint on 
regions in the 3D views (orthographic or perspective), which also overlap in 
2D UV view, then you may encounter painting artifacts, as Mari is forced to 
choose which of the conflicting overlapping paint strokes to bake down. To 
avoid this, you should only apply paint to one of the overlapped regions at a 
time in the 3D views.

For example, if you paint a face where the left and right halves have been 
mirrored with overlapping UVs, then you should aim to only paint on one 
half of the face to avoid paint clashes.

Models to paint in Mari should not have:

• UVs that go over 10 on the U axis — these are ignored.

• Stacked UVs — these cannot be individually selected in UV view. If you 
do have stacked UVs and want to select an individual UV, you need to 
select it in either Ortho or Perspective view first, and then switch back 
to UV view.

NOTE: Paint clashing due to overlapping UVs cannot occur in the UV 
view, so you can always paint your model in that view if you find that 
your model is particularly tricky to paint in 3D views.
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Model Requirements 
Models to paint in Mari cannot have:

• Negative UVs — painting on these is not possible.

For Ptex modelling, please see the Ptex Modelling Requirements in Mari 
in the User Guide for more information.
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4  THE MARI WORKSPACE

What It Looks 
Like

Here is an illustration of the Mari workspace that displays when you first 
open the program.

Workspace

Menubar To select Mari commands (many of which are also available using 
shortcut keys and/or icons).

Toolbars To click icons for common Mari functions or settings.

Canvas Where you view and paint your geometry.

Tabs To switch between views.

Palettes Controls for viewing and changing different aspects of what's on the 
canvas.

Disk Usage Bar Displays how much of your cache disk has been filled.

Statusbar Information about the project generally, progress of long operations 
(such as baking), and icons.

Menubar

Toolbars

Canvas

Tabs

Palettes

StatusbarDisk Usage Bar



5  MANAGING PROJECTS

A Mari project stores your work on geometries, and any associated 
textures. Mari's Project tab holds all the projects you are working on.

Creating a New 
Project

1. Do one of the following:

The New Project dialog box displays.

2. Set the project's Name (for you to identify it only — this is not a 
filename).

3. Select the geometry file for the project in the Path field. The drop-down 

lists the last 10 files selected, or you can click  to browse to a file.

Select from 
menubar

or click on 
toolbar

or click on the 
Project tab

or type 
shortcut key

File > New New Ctrl+N
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Creating a New Project 
Various mesh options display in the dialog directly under Path, depend-
ing on whether you open an .obj or .ptx file. 

• .obj files: you can select options for the Mapping Scheme, Selection 
Sets, and Multiple Geometries Per Object.

• .ptx files: you can choose whether the mesh data in the file represents 
a single new Object or, when there are multiple input files, if the mesh 
data in each file represents a separate geometry in a single new 
Object.

For more information on the Mesh Options, please see Create a New 
Project in the Ptex chapter of the User Guide.

4. If you are loading an animated sequence, Mesh Options displays with 
the additional options Start Frame, End Frame, Single Frame, and All 
Frames. These provide the frame range to view either user-defined start 
and end frames, a single frame, or every frame.

5. To create a project from multiple files, browse to a folder and select 
multiple files from the directory, before clicking Open. 

The selected files are all shown in the Path field. These files are stored 
in the history as a single project under the assigned name.
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6. In the Texture section, click to select which of the channels in the list to 
create. You can select a different Category from the list – the set of 
channels updates with channels for your selected category.

Click boxes under Create and Import to set the options. You can right-
click to get a dropdown menu allowing you to easily create or import all 
the channels.

7. Click OK.

Mari checks the model for any errors that might prevent it from pro-
cessing; for example, touch border edges. A “Mesh Sanity Check” dialog 
displays any warnings or errors. (Errors cancel opening the model, but 
you can continue with warnings.)

8. Click to Continue. 

Mari renders your selection and displays it on the canvas.

Opening Existing 
Projects

1. Click on the Projects tab. 

This shows all the projects you have on your computer.

TIP: Click Scan to make Mari scan the project's root path for any existing 
textures. If any textures exist for your channels, Mari shows a green dot 
next to the channel. You can select to import these textures.

As with the project name, the channel Name is for you to identify it only 
— when you export you can select a different name.

For the Type, choose Color for anything color-dependent (and Mari 
applies the viewer LUT automatically), or Scalar for a mask or 
displacement.

If you select a different Depth or resolution, file sizes can vary 
dramatically (for example, a 2K RGB “Byte” texture file is 2MB — whereas 
a 4K “Float” is 172MB).

NOTE: For information on model requirements in Mari, refer to Mari 
Model Requirements on page 19.

TIP: Depending on the size and complexity of textures, it can take several 
minutes the first time you load them into a Mari project. Once saved, 
however, the project should open quickly in future.
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Saving Your Project 
2. Double-click on the project to open.

Using the Command 
Line

You can also open Mari and a specific, existing project, as well as archives 
using the command line. From the Run dialog on your computer, use a 
command in the format of:

./mari /tmp/testproject.mra

By specifying the project name, UUID, folder path, or project.mri path, you 
open Mari and the designated project.

The command line can also be used to run scripts that contain a Python call 
to open a project. From the Run dialog on your computer, use a command in 
the format of:

./mari example_script.py

The example_script should contain the Python call to open a project.

Saving Your 
Project

Do one of the following:

NOTE: On project load, Mari looks for metadata that is over 250MB and 
discards anything that is over this size. This is intended to strip corrupt 
and problematic data, and also affects metadata added via the Python 
API.

Select from menubar or click on toolbar or type shortcut key

File > Save Ctrl+S

TIP: Save your project often!

•   Note that while your textures remain cached locally, saving does not 
export them, so export often too!

•   If you don't need to save (no changes since the last save), the toolbar 
icon is gray.
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6  CONFIGURING YOUR WORKSPACE

The Mari workspace is completely configurable. As detailed on the pages 
that follow, you can customize how palettes display, your own personalized 
sets of brushes and colors, and shortcut keys.

Palettes Mari uses a number of palettes — windows that you can move around your 
workspace, with specific information and tools for working on your project. 
For example, the Channels palette shows all the channels in the project, and 
has controls for editing the channels.

To open palettes:

To move, size and arrange palettes:

Select from menubar or right-click on the menubar or toolbar and select

View > Palettes > <palette 
name>

<palette name>

To... Do this...

Undock and move a 
palette

Grab and drag it by its title bar to anywhere on your screen. 

(Or click  to undock, and then drag by its title bar).

Dock a palette to the window Move it to one of the edges of the Mari window. A dotted 
line displays along the edge where it can dock.

Dock a palette to another 
palette

Move it over another undocked palette. A dotted line dis-
plays where it can dock.

Size a docked palette Grab and drag the dotted bar along the bottom or side.

Size a floating palette Drag an edge or corner.

Stack palettes Drag and drop them directly on top of one another. 
Tabs appear for selecting which of the stacked palettes to 
display.
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Shelves 
Shelves The Shelf palette lets you store customized “shelves” of brushes, colors, and 
images. You can also share them with others.

Mari has the following kinds of shelves:

• The Menu shelf stores seven items available from the F9 on-screen 
menu. These items must be numbered from 1-7 to appear.

• The Personal shelf stores items you select and configure for all projects.

• The Basic Brushes shelf stores a set of predefined basic brushes.

• The Hard Surface Brushes shelf stores a set of predefined hard surface 
brushes.

• The Organic Brushes shelf stores a set of predefined organic brushes.

• Customized shelves you create store items you select and configure for 
all projects.

Customizing Shelves To add an item (brush, color, or image) to a shelf, drag it onto the shelf.
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7  CHANNELS

Channels hold layers stacks, filled with paint layers, procedurals, and 
adjustments in your project. For example, a project might have channels for 
diffuse color, displacement, or specularity, but each of those channels 
contain individual layers for paint, masks, and filters.

Channels can then be used in shader inputs so you can adjust the amount of 
diffuse or specularity, among other things.

Adding a Channel 
to a Project

1. Do one of the following:

The Add Channel dialog box displays, allowing you to set the options for 
the new channel.

2. Select a name, size, depth, color and file space, and base color for the 
channel (as with a new project), and click Ok.

Select from the Channels 
menu

or from the Channels 
palette, click

or right-click on the Channels 
palette and select

Add Channel Add Channel



CHANNELS 29
Adding a Set of Channels 
The new channel displays in the Channels palette.

Adding a Set of 
Channels

1. Do one of the following:

The Channel Presets dialog box displays.

2. Select the Import and Resize options for the channels you're creating.

The list of channels at the bottom of the dialog box allows you to set 
whether you want to create the preset channels from scratch or from an 
imported file. Set the channel options as you would in the Add Channel 
dialog.

3. If you have existing textures to import into the new channels, set the 
Root Path and make sure that the Files for each channel show the 
correct texture files.

NOTE: If you are working with a Ptex project, the patch Size option 
appears grayed out, as the .ptx format doesn’t work with patches.

TIP: If there are multiple objects in your project, there is no Ok button in 
the Add Channel dialog. Instead, you need to choose whether you want to 
add the channel to only the current object or All Objects.

Select from the Channels menu or right-click on the Channels palette and select

Channel Presets Channel Presets
Mari 2.0v1The Foundry



CHANNELS 30
Adding a Set of Channels 
4. Click OK to create and import the new channels.

TIP: To toggle quickly between the last two selected channels (while in 
the painting canvas), press T.

For other options, such as locking or resizing a channel, right-click in the 
Channels palette or click on the Channels menu.
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8  LAYERS

Layers are the source of your paint textures in a project. Layers are created 
as part of a layer stack, which is in turn held within a specific channel. Each 
channel has a different layer stack that contains a new set of layers. You 
can create paint layers, layer masks, adjustments, procedurals, and layer 
groups within the Layers palette.

Painting layers or adding adjustments and procedurals to a layer stack 
behaves in a top-down manner, so that layers that appear at the top of the 
stack take precedence over layers further down. In this way, if layers have 
overlapping paint areas, only the overlapping paint in the top-most layer is 
visible.

Add a Layer to a 
Layer Stack

1. Do one of the following:

A new layer appears in the Layers palette, above any other layers in the 
layer stack.

2. The paintable icon  appears orange when the layer is selected and 

the paintable component is active.

Add a Mask to a 
Layer

1. Do one of the following:

A layer mask is added to the selected layer in the Layers palette.

Select from the Layers menu
or from the Layers 
palette, click

or right-click on any layer in the 
Layers palette and select

Add New Layer Add New Layer

Select from the Layers menu
or from the Layers 
palette, click

or right-click on any layer in the 
Layers palette and select

Layer Mask > Add Mask > 
Reveal All or From Alpha

Layer Mask > Add Mask > 
Reveal All or From Alpha
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Add an Adjustment to a Layer Stack 
2. The mask icon  appears orange when the layer is selected and the 

mask component is active. 

Add an 
Adjustment to a 
Layer Stack

1. Do one of the following:

An adjustment layer appears in the Layers palette, above any other lay-
ers in the layer stack.

2. The adjustment icon  appears orange when the layer is selected 

and the adjustment component is active.

Add a Procedural 
to a Layer Stack

1. Do one of the following:

A procedural layer appears in the Layers palette, above any other layers 
in the layer stack.

2. The procedural icon  appears orange when the layer is selected and 

the procedural component is active.

TIP: To switch back and forth between components on a layer, simply 
click on the component icons.

Select from the Layers menu
or from the Layers 
palette, click

or right-click on any layer in the 
Layers palette and select

Add Adjustment Layer > any 
adjustment from the drop-
down menu

Add Adjustment Layer > any 
adjustment from the dropdown 
menu

Select from the Layers menu
or from the Layers 
palette, click

or right-click on any layer in the 
Layers palette and select

Add Procedural Layer > any 
procedural from the drop-
down menu or sub-menus.

Add Procedural Layer > any 
procedural from the dropdown 
menu
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Group Layers 
Group Layers 1. Do one of the following:

If you chose to add an empty layer group, this group is added as a new 
layer in the Layers palette, above any other layers in the layer stack.

If you chose to group existing layers together in the layer stack, you 
must have one or more layers selected. This group is created at the 
point of the top-most selected layer.

2. To add new layers to an empty layer group, simply drag existing layers 
into the group.

Alternatively, once you’ve added a layer to the group, select any layer 
within it and Add New Layer.

3. All layers within a group maintain any component icons associated with 

them. The group parent layer has a folder icon  to distinguish it as 

the group layer.

Select from the Layers menu
or from the Layers 
palette, click

or right-click on any layer in the 
Layers palette and select

Add Empty Layer Group or 
Group Layers

Add Empty Layer Group or 
Group Layer
MariThe Foundry



9  SHADERS

Shaders control how Mari displays the model on the canvas. Mari's default 
shaders show the paint in either the Current Channel, Current Layer and 
Below, Current Layer, or Current Paint Target.

You can also create your own custom shaders by combining diffuse and 
specular shader types then setting up channels in the shader component 
inputs to specify how they appear in the shader. For example, if I use a 
Lambertian/Beckman shader, I can still specify channels for components 
such as emissive.

So you can build a shader that takes the details from multiple channels
in your project to render the canvas on-screen.

Create a Shader 1. Do one of the following:

The new shader displays in the list, with shader components shown at 
the bottom of the palette.

TIP: Shaders don’t affect the contents of the channels. For example, if 
you have a shader with channels set in both the diffuse and specular 
color inputs, the model on-screen displays the effects of both channels. 
However, the channels are still separate and contain different data.

Select from the Shading menu
or from the Shaders 
palette, click

or right-click on the Shaders 
palette and select

Add New Shader > any shader 
from the dropdown menu

any shader from the dropdown 
menu
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Create a Shader 
2. Instead of choosing shader types from the menu (Phong or Blinn, for 
example) you can specify the diffuse and specular by selecting Choose 
Diffuse and Specular from the menu.

The Create Shader dialog appears.

Select your Diffuse and Specular shader options and click OK.

3. All shaders are created with the Current Channel in the Diffuse Color 
shader component. You can change this, and set the other components 
by clicking on the dropdown menu next to the component name and 
selecting the channel.

4. If you haven’t yet created a channel to use in a specific shader 

component, click the add channel icon  next to the shader 

component.

The Add Channel dialog box appears. Select the options for your channel 
from the dialog and click Ok.

5. Once you’ve set a channel to the shader component, adjust the value or 
level of the component, using the sliders.
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Create a Shader 
You can add as many shaders as you need and compare them or switch back 
to the default shaders at any time.

TIP: If you build a shader that takes data from multiple channels, it can be 
hard to remember which channel you're currently editing. In this case, you 
can switch back to one of the default shaders, which just shows the 
contents of the current channel, layer and below, layer, or paint target.
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10  CHANGING THE VIEW

As described below, Mari includes features for 3D navigation to view your 
model from various angles and perspectives, change the lighting on the 
mesh, and change the resolution of textures.

3D Navigation You can move the view by holding down Alt.

The navigation toolbar also provides the ability to control panning, 
zooming, rolling, and orbiting, with various settings for each. You can easily 
access the toolbar, shown below, at any time using the following buttons:

• Reset navigation settings to default.

• Enable panning to move the model on the screen.

• Enable zooming to zoom in or out on the model.

• Enable rolling to turn on the momentum system.

• Enable orbiting mimics the orbiting system in Maya and allows you to 
move the camera around the model.

To... hold down Alt and

Zoom in and out Ctrl-click and drag OR Right-click and drag

Pan left and right Shift-click and drag OR Middle-click and drag

Rotate the model Left-click and drag

To...

Spin the camera Ctrl+R+left-click and drag

TIP: By default, Mari uses momentum when you are moving the view. 
When you let go of the mouse button, the model slowly coasts to a stop. 
You can turn this behavior off so that the model only moves when you are 
holding the mouse button down. 

To do so, change the settings in the preferences by unchecking 
Momentum Enabled via Edit > Preferences > Navigation.
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Lighting 
• Disable rotational snapping gives options to turn on and change the 
angle at which the camera view snaps to (45 degrees or 90 degrees).

You can also use the keys 1-6 to switch between preset views (left, right, 
top, bottom, front, and back).

In the UV view, you can also rotate or reset the model for easier viewing 
and painting. Press 1 to reset the model back to its default position. Press 
2, 3, and 4 to rotate the model counter-clockwise in 90-degree increments 
from the default position.

Press Home to cycle between hiding all palettes, hiding docked palettes and 
showing hidden palettes.

Use the tabs at the top of the canvas to switch between:

• UV - a grid view showing the UV patches.

• Ortho/UV - a split screen showing the UV patches and the orthographic 
view.

• Perspective - a perspective camera view, or

• Ortho - an orthographic camera view.

Lighting You can change the lighting on the main mesh by clicking on the toolbar:

TIP: You can also use the , , and  toolbar buttons or the 

F10, F11, and F12 keyboard shortcuts to activate a particular view on 
any tab.

Flat Basic Full
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Lighting 
Mari has four custom lights, which appear on the drawing canvas .

You can set the light details in the Lights palette. Mari uses these in the 
Basic and Full lighting modes:

• To turn a light on or off, click on the  icon in the list, or use the 

General > On checkbox.

• To change a light, click on it in the Lights list, and then set the color and 
strength.

• Select whether the light is fixed to the Scene or Camera.

• To move a light around, select the Pan Object tool , then click and 

drag the light around on the canvas.

• To move a light to the camera position, click on the  icon on the 

Lights palette, or right-click on the light and select Move to Camera 
Position.

You can toggle the shadows on and off in the Lighting toolbar:

This simply toggles the display of shadows on the canvas, but does not 
disable shadow processing. 

• You can control Shadow Rendering through the option on the Lights 
palette.

• Toggle shadows by clicking on the Shadows icon in the Lighting toolbar 
or the Shading menu.

• If you want to enable shadow processing, you need to enable the Depth 
Projections checkbox under Preferences > Data | Graphics Card. By 
default, this preference is disabled.

Shadows on Shadows off
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11  PAINTING

Painting in Mari is similar to other standard paint programs. Paint using the 
various tools, then bake it onto your model. Most tools work on unbaked 
paint, but one or two also work directly on the baked paint on the surface.

To select a tool:
Choose from your shelves or the Tools toolbar:

TIP: Each tool has a set of keys that control how it works. By default, the 
option keys for the current tool are shown on-screen at the top of the 
canvas.

Paint tools

Select Marquee select Transform paint buffer
Zoom paint buffer

Pan object Vector Inspector Blur Warp

Slerp Pinup Paint Vector Paint

Erase Paint through Paint gradient Clonestamp

Towbrush Color picker/ Pixel 
analyzer
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Painting a Constant Color 
Painting a 
Constant Color

1. Click  to select the Paint tool.

2. Click and drag to paint on the model.

Customizing 
Your Brush

1. Open the Brush Editor palette. 

The Brush Editor displays.

2. You can select a brush to modify from those available in your Shelves.

TIP: You can paint a straight line by:

•   clicking one end point, moving the cursor, pressing Shift and clicking 
the second end point.

•   pressing Shift and holding down the mouse button while moving hori-
zontally or vertically.

TIP: Resize the brush editor palette to minimize scrolling. There are many 
options for customizing your brush, including setting values for Paint, 
Pressure, Radius, Rotation, Bitmaps to use, Geometry and Noise. You can 
test the brush in the scratch pad at the bottom of the palette.
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“Painting Through” an Image 
3. When you have finished editing a brush, click  to add it to the 

selected shelf.

“Painting 
Through” an 
Image

1. Open the Image Manager palette.

2. To load an image, click , navigate to and select the image file, and 

click Open.

A thumbnail of the image displays, along with information about the 
selected image.

3. In the Tools toolbar, click  (the Paint Through tool). 

4. Drag and drop the image from the Image Manager to the canvas. 

5. Adjust the image size and position:

6. Paint!

To... Do this...

Resize Grab and drag its edges or corners, or press Ctrl+Shift then click 
and drag.

Move Grab the “handle” in the center of the image (or press Shift and 
click anywhere on the image), and drag.

Rotate Click and drag outside the image, or press Ctrl and drag inside the 
image. 

Press Shift when dragging outside the image to rotate in incre-
ments.

Crop Double-click the image in the Image Manager, drag the area you 

want to crop, and click .

Change the opacity In the Tool Properties palette, select Texture > Preview, and 
change the Preview Alpha (enter a number or drag the slider). Pre-
multiply alpha if your image has transparency.

Reset the image In the Tool Properties palette, select Texture > Transform > Reset.

TIP: You can quickly switch between the Paint and Paint Through tools by 
pressing P and U. To hide the image, hold the ? key, to paint the whole 
image onto the model in one step, press the ' (apostrophe) key. Toggle 
repeat image to paint past the edge of the floating image and have the 
paint continue, by pressing the ; (semicolon) key.
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Clone Stamping 
Clone Stamping 1. Click  to select the clone stamping tool.

2. Use the Source menu on the toolbar to select where to take the clone 
source from. You can choose from the current paint target, an image, or 
any of the paint layers in the project.

3. If you’re using an image as your clone source, hold down the Ctrl key 
over the image and click to select the clone source point.

4. Paint to clone your selection on the model.

Moving and Warping 
Paint

To move paint on the model before baking:

1. Click  to select the transform tool.

2. Left-click anywhere on the paint buffer and drag to move the painting 
around on the model.

3. Ctrl+left-click and drag to rotate the painting, or left-click and drag 
outside the paint buffer.

TIP: When cloning from a paint layer, you can clone directly from the 
surface. In this mode, the tool clones the paint from the paint layer 
surface straight up into the paint buffer directly above that point. This 
lets you copy the model's surface into the paint buffer so you can edit it 
and then re-bake.

To use this mode, hold down Ctrl+Meta (or Windows key) when you click 
to set the origin point.
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Baking Paint onto the Model 
4. Ctrl+Shift+left-click and drag to resize the painting, or grab the corners 
of the paint buffer and drag.

To warp paint before baking:

Baking Paint 
onto the Model

To bake paint onto your model:

1. Make sure all patches you want to bake are selected.

2. Do one of the following:

Blurring Baked 
Paint

1. Click  to select the blur tool.

TIP: The paint buffer is visible on-screen as a white box, but it may be 
larger than the view window and not visible. It becomes obvious if you 
move or resize the painting. To reset the paint buffer to its default values 
click the Reset button in the Painting palette under Paint Buffer > 
Transform.

Using this tool... You can...

 Warp
Shift-click and drag to create a warp grid. Click and drag the 
points around to warp the paint. To increase or decrease the 
grid resolution, press the up or down arrow keys.

 Slerp
Use the Slerp Mode menu on the toolbar to set the mode 
(from Pull, Grow, Shrink, or Rotate). Click and drag to apply 
your effect. Erase distortion by selecting the Erase mode.

 Pinup
Shift-click to set “pins”. Then click and drag to move the pins. 
You can use pins to protect parts of the paint that you don't 
want affected by the distortion.

Type shortcut key or click on statusbar icon

B

TIP: Whenever you change your view of the model, it bakes automatically. 
You can change this setting in the Projection palette if required.
Mari 2.0v1The Foundry



PAINTING 45
Blurring Baked Paint 
2. Left-click and drag to blur paint baked on the surface.

TIP: As with the paint tools, you can edit the blur brush tip. When you 
have finished blurring the paint, you need to bake.
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12  EXPORTING AND IMPORTING

You can export and import both channels and layers in your project, both in 
’flat’ formats, such as TIF, and in layered formats, such as PSD or PSB. This 
is especially useful when exporting multiple layers or channels that you 
don’t want to take up a lot of space, or when you want to use the final 
output of a channel in another application.

Exporting 
Channels

To export the current channel, select a single channel to export and do one 
of the following:

The Export dialog box displays.

Select from the Channels menu
or right-click on the Channels palette and 
select

Export > Export Current Channel Export > Export Current Channel

Export > Export Current Channel Flattened Export > Export Current Channel Flattened
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Exporting Channels 
To export all channels in your project, do one of the following:

The Export dialog box displays.

To export everything in your project, including all layers, channels, and 
patches, do one of the following:

The Export All dialog box displays.

1. On the Sequence tab, enter the Path where you want to store the 
export, or use the browse panes (the navigation panes below) to browse 
to it.

2. If you are looking for a specific folder or file, you can use the Filter field 
to specify a name or file format to search for.

3. For the Template, either use the default filename template or edit it as 
required.

4. Click Export All Patches (to export all patches in the current channel) to 
export with the settings you’ve chosen.

Select from the Channels menu or right-click in Channels palette and select

Export > Export All Channels Export > Export All Channels

Export > Export All Channels Flattened Export > Export All Channels Flattened

Select from the Channels menu or right-click in Channels palette and select

Export > Export Everything Export > Export Everything

Export > Export Everything Flattened Export > Export Everything Flattened

NOTE: All of the methods for exporting textures shown above follow the 
same instructions once they reach the Export dialog:

NOTE: If Small Textures is enabled, Mari exports any patches that you 
haven't painted yet, or have painted as a single color, as 8x8-pixel 
textures. When you start to paint on a particular patch, Mari exports it 
as the correct size.

NOTE: The steps above assume you are exporting a sequence of patches 
with the udim number (1001, 1002, etc.) in the file names. For more 
information on how UDIM numbers are allocated to patches, please see 
the section on Using UDIM Values in the Working with Patches chapter of 
the Mari User Guide.
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Exporting Layers 
Exporting Layers To export selected layers, select any layers you want to export and do one 
of the following:

The Export dialog box displays.

To export all layers in the channel, do one of the following:

The Export All dialog box displays.

NOTE: If you'd rather assign individual files to each patch, you can do so 
on the Named Files tab of the Export Channel dialog. Click the buttons on 
the right to open a file browser and pick a file for each patch. Then, click 
Export All Patches to export the files. Note that by default the Named 
Files tab doesn't display if you have more than 20 patches in your object. 
To change this number, you can use the Patch Cutoff preference or set 
the MARI_NAMEDFILEIMPORT_SEQUENCELIMIT environment variable to a 
new value.

TIP: Make sure you check the path and name carefully, especially if you 
have been swapping between assets — Mari defaults to the last place 
you've exported. Don't risk overwriting your textures!

Select from the Layers menu or right-click on the Layers palette and select

Export > Export Selected Layers Export > Export Selected Layers

Export > Export Selected Layers Flattened Export > Export Selected Layers Flattened

Select from the Layers menu or right-click in Layers palette and select

Export > Export All Layer Export > Export All Layers

Export > Export All Layers Flattened Export > Export All Layers Flattened

NOTE: All of the methods for exporting layers shown above follow the 
same instructions as for exporting channels once they reach the Export 
dialog. These instructions begin on step 1 on page 47.
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Importing Channels 
Importing 
Channels

To import into your current channel’s layer stack, do one of the following:

The Import dialog box displays.

1. Enter the Path to the files to import, or use the browse panes (the two 
left-hand navigation panes) to browse to them.

2. If you are looking for a specific folder or file, you can use the Filter field 
to specify a name or file format to search for.

3. For the Template, either use the default filename template or edit it as 
required.

4. To import all patches from their matching files, click Import All Patches. 
This imports files with the settings you’ve chosen.

Select from the Channels menu or right-click in Channels palette and select

Import > Import into Layer Stack Import > Import into Layer Stack

NOTE: The steps above assume you are importing a sequence of patches 
with the udim number (1001, 1002, etc.) in the file names. For more 
information on how UDIM numbers are allocated to patches, please see 
the section on Using UDIM Values in the Working with Patches chapter of 
the User Guide.
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Importing Channels 
To import into a new channel, do one of the following:

The Add Channel dialog box displays.

1. Follow the instructions for setting up a new channel in Adding a Channel 
to a Project on page 28, and when you’ve finished, click Ok.

The Import dialog box displays.

2. Enter the Path for the files to import, or use the browse panes (the two 
left-hand navigation panes) to browse to them.

NOTE: If you'd rather assign individual files to each patch, you can do so 
on the Named Files tab of the Import Channel dialog. Click the buttons on 
the right to open a file browser and pick a file for each patch. Then, click 
Import All Patches to import the files. Note that by default the Named 
Files tab doesn't display if you have more than 20 patches in your object. 
To change this number, you can use the Patch Cutoff preference or set 
the MARI_NAMEDFILEIMPORT_SEQUENCELIMIT environment variable to a 
new value.

Select from the Channels menu or right-click in Channels palette and select

Import > Import into New Channel Import > Import into New Channel

NOTE: The steps above assume you are importing a sequence of patches 
with the udim number (1001, 1002, etc.) in the file names. For more 
information on how UDIM numbers are allocated to patches, please see 
the section on Using UDIM Values in the Working with Patches chapter of 
the User Guide.

NOTE: If you'd rather assign individual files to each patch, you can do so 
on the Named Files tab of the Import Channel dialog. Click the buttons on 
the right to open a file browser and pick a file for each patch. Then, click 
Import All Patches to import the files. Note that by default the Named 
Files tab doesn't display if you have more than 20 patches in your object. 
To change this number, you can use the Patch Cutoff preference or set 
the MARI_NAMEDFILEIMPORT_SEQUENCELIMIT environment variable to a 
new value.
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Importing Layers 
Importing Layers To import into the current layer, do one of the following:

The Import dialog box displays.

To import as a layer in the current layer stack, do one of the following:

The Import dialog box displays.

1. Enter the Path for the files to import, or use the browse panes (the two 
left-hand navigation panes) to browse to them.

2. If you are looking for a specific folder or file, you can use the Filter field 
to specify a name or file format to search for.

3. For the Template, either use the default filename template or edit it as 
required.

4. Click Import All Patches (to import all patches from the file) to import 
with the settings you’ve chosen

Select from the Layers menu or right-click in Layers palette and select

Import > Import into Layer Import > Import into Layer

Select from the Layers menu or right-click in Layers palette and select

Import > Import into Layer Stack Import into Layer Stack

NOTE: The steps above assume you are importing a sequence of patches 
with the udim number (1001, 1002, etc.) in the file names. For more 
information on how UDIM numbers are allocated to patches, please see 
the section on Using UDIM Values in the Working with Patches chapter of 
the User Guide.

NOTE: If you'd rather assign individual files to each patch, you can do so 
on the Named Files tab of the Import Channel dialog. Click the buttons on 
the right to open a file browser and pick a file for each patch. Then, click 
Import All Patches to import the files. Note that by default the Named 
Files tab doesn't display if you have more than 20 patches in your object. 
To change this number, you can use the Patch Cutoff preference or set 
the MARI_NAMEDFILEIMPORT_SEQUENCELIMIT environment variable to a 
new value.
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13  ABOUT THE TUTORIALS

The tutorials included in this manual are:

• Tutorial 1: Setting up a Mari Project

• Tutorial 2: Setting the View and Lighting

• Tutorial 3: Painting!

• Tutorial 4: Painting Through and Clone Stamping

• Tutorial 5: Exporting and Importing

The tutorials are self-paced but designed to take roughly 10 to 45 minutes 
each. You might find yourself breezing through one while spending a lot of 
time on another to soak up details you're not quite sure about.

Download 
Sample Files

Sample files are provided for use with all of the tutorials. You can download 
these files from our web site at www.thefoundry.co.uk/mari and try Mari 
out on them. From the Mari product page, click on the Demo Assets link.

Tutorial Format Mari tutorials include steps, which are the specific instructions for you to 
perform. Steps are organized into major actions. For example, all the steps 
involved in loading the geometry when creating a project are grouped on a 
page with the title “Load geometry”. The individual steps are numbered, and 
describe what you should do and what happens in Mari. For example:

1. Next, to bring in the geometry, click .

The Pick Mesh dialog box displays.

Note that the response to each step (what happens when you do it) is in 
italics, and the name of any dialog box or UI item that displays as part of 
that response is bold.

http://www.thefoundry.co.uk/mari


TUTORIAL 1: SETTING UP A MARI PROJECT

About this 
lesson

What This Lesson 
Teaches You

This lesson teaches you what Mari projects are, and how to create them.

What You Should 
Know Before 
Starting This Lesson

This lesson assumes: 

• a basic knowledge of computers and graphics applications

• that you have read the Mari Getting Started Guide up to this point

• that you know how to start Mari (see Launch Mari).

Resources You Need 
to Complete This 
Lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample file:

• blacksmith_body.obj 

How Long Should It 
Take? 

Plan on spending about 20 minutes to complete this lesson.

About Mari 
Projects

A Mari project holds your work on geometries and associated textures. 
Once you've created a Mari project, you can work on it, save and close — 
and then re-open it to continue working on the same textures later.

Projects also hold other items, such as projectors, shaders, and so on. Mari 
saves some settings at the project level. For instance, each project has:

• a project shelf, to hold brushes, colors, and images for you to use 
specifically in that project, and

• contents of the various palettes — Image Manager, Brush Editor, and so 
on.
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Open a New Project 
When you first create a project, you can specify its parameters, including:

• the details (such as resolution and color depth) of the initial channel in 
the project.

• the range of animation frames to import.

Steps for Creating 
Mari Projects

To create a Mari project, follow these steps:

1. Open a New Project

2. Specify Project Options

3. Load Geometry

4. Save Your Project

Open a New 
Project

1. Start Mari (see Launch Mari). 

The Mari workspace displays, showing the Projects tab. This holds all 
the projects you have been working on.

2. As with most commands in Mari, you can select the New Project option a 
few different ways:

• from the File menu, select New,

• click  on the toolbar,

• click the New button,

• right-click in the Projects tab and select New from the dropdown 
menu, or 

• press the Ctrl+N shortcut key.

Pick any one of the options above. 

The New Project dialog box displays.
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Specify Project Options 
The New Project dialog box has three parts:

• Name — a name for your project. 

• Geometry — the model you'll be painting on.

• Texture — parameters for the textures you'll be creating.

Next we'll specify the name and texture options, and then select the 
geometry.

Specify Project 
Options

1. For the project Name, type 1-Blacksmith.

NOTE: For more information on what kind of models Mari expects, see 
Mari Model Requirements.This model displays with no errors. Mari loads 
the geometry and displays it in your workspace.

TIP: For more on the different options in the New Project dialog box — 
and other dialog boxes illustrated in this tutorial, see the Mari Reference 
Guide.
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Load Geometry 
2. For the Texture options, right-click on the list of channels and select 
Create All. 

Load Geometry 1. Next, to bring in the Geometry, click .

The Pick Mesh dialog box displays.
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Load Geometry 
2. Navigate to your tutorial folder, click to highlight blacksmith_body.obj, 
and click Open.

3. Click Ok.

Mari conducts a quick “sanity check” on the model to make sure there 
are no obvious problems. If there are any problems, it displays warnings 
or errors. If there are warnings, you can continue. If there are errors, 
you must stop and fix them.

NOTE: When you load geometry, Mesh Options appear for the model 
you’ve entered in the Path field. For this tutorial, leave the mesh options 
as they are, but for more information on the Mesh Options refer to the 
New Project Dialog chapter in the Mari Reference Guide and the Ptex 
chapter in the Mari User Guide.

TIP: Depending on the size and complexity of a model, it can take several 
minutes the first time you load it into a Mari project. Once saved, 
however, the project should open quickly in future.
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Save Your Project 
Save Your 
Project

Save your project — again you can do this a few ways:

• from the File menu, select Save,

• click  on the toolbar, or

• press the shortcut key Ctrl+S.

Mari saves the project into its cache directory. Now, if you click on the 
Projects tab at the top of the screen, you see your new project in the list.

Where Do You Go 
from Here?

At this point, you should have a basic idea of what a Mari project is and how 
to create one. You learned how to:

• Name the project.

• Set texture options.

• Load geometry.

• Save the project.

Next, you'll use this project to practice some basics about setting the 
camera and lighting on the geometry in your project, before you begin to 
paint on it. When you're ready, proceed to Tutorial 2: Setting the View and 
Lighting.
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TUTORIAL 2: SETTING THE VIEW AND LIGHTING

About This 
Lesson

What This Lesson 
Teaches You

This lesson teaches you how to open a Mari project, and then set the view 
and lighting on your geometry (before painting on it).

Setting the view includes:

• rotating

• zooming in or out

• panning

• viewing from six basic directions

• displaying a split view showing a 3D view plus UV patches

Setting the lighting includes:

• picking “flat”, “basic”, or “full” lighting,

• choosing whether to toggle shadows on or off,

• moving lights around and adjusting their properties.

What You Should 
Know Before 
Starting This Lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read the Mari Getting Started Guide up to this point

• that you know how to start Mari (see Launch Mari)

• that you have completed Tutorial 1: Setting up a Mari Project.

Resources You Need 
to Complete This 
Lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample file:

• 1-Blacksmith — the Mari project file you created in Tutorial 1

How Long Should It 
Take?

Plan on spending about 25 minutes to complete this lesson.
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About Mari View and Lighting 
About Mari View 
and Lighting

The view in Mari is a view on the object you are painting. By default, Mari 
has four types of view:

• UV — this gives you a “flat” view of the patches in the model.

• Perspective — this show the model as a whole in 3D space, through a 
perspective camera. 

• Ortho — this shows the model as a whole in 3D space, through an 
orthographic camera.

• Ortho/UV — this is a split screen, showing both the UV patches and the 
orthographic view.

You can move each view separately.

Within the views, you can:

• Spin or rotate the model (3D views only). Spinning turns the model on 
one axis, while rotating lets you turn the model in all three axes. Think of 
spinning as like turning the model on a turntable, while rotate is turning 
it around in midair. 

• Pan to move the view across the model. 

UV View  Ortho View

Ortho/UV View

TIP: You can also use the , , and  toolbar buttons or the 

F10, F11, and F12 keyboard shortcuts to activate a particular view on 
any tab.
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Open Your Project 
• Zoom in or out. 

• Focus on a selected patch. 

You separately configure the lighting on the object, by choosing pre- set 
settings for “flat”, “basic”, or “full”, or specifying fine details such as 
shading parameters and separate lighting for each of the four configurable 
lights.

Steps for Setting the 
Camera and Lighting

To set the camera and lighting, follow these steps:

1. Open Your Project

2. Adjust the View

3. Adjust the Lighting

Open Your 
Project

1. Start Mari (see Launch Mari).

The Mari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open 
it.

Your project opens and switches to the Ortho view.
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Adjust the View 
Adjust the View To adjust the view on your project, you can zoom, pan, rotate, choose one 
of six pre-set views, display your model and patches in a split screen, or use 
perspective and orthographic views.

1. To zoom out and in, hold down the Alt key, right-click and drag the cur-
sor to the left and right.

2. To pan, hold down the Alt key and middle-click (or hold Alt and Shift and 
left-click and drag).
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Adjust the View 
3. To rotate, hold down the Alt key and left-click and drag.

4. To view from six basic preset angles (camera “left”, “right”, “top”, 
“bottom”, “front”, and “rear”), press 1, 2, 3, 4, 5, or 6, or select the 
angle from the Camera menu.

5. To see a flat view of the UV patches on the model, click the UV tab.

TIP: You can also “spin” around a fixed point by pressing Ctrl+R, left-
clicking, and dragging. When you rotate or spin, the pivot point is located 
in the center of the current view.
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Adjust the View 
To see a split screen showing both the Ortho and UV views, click the Ortho/
UV tab.

6. To see a perspective view of your model, click the Perspective tab (or 
press F11).
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Adjust the View 
In the Perspective view, you can alter your model’s appearance in the 
viewer by entering Near, Far, and FoV values in the Canvas toolbar. See 
chapter 2 in the Mari User Guide: Set the perspective camera details for 
more information.

7. To see an orthographic view of your model, click the Ortho tab (or press 
F10). This is the default view mode, that is, the view you see when you 
start Mari.

8. To switch the view to display all selected patches, press A.

NOTE: The model is in the same position in steps 7 and 8; only the view 
mode has changed. Notice that the model’s arms appear closer to the 
body due to the application of perspective.
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Adjust the Lighting 
If you don't have any patches selected, the view focuses on the model as 
a whole (changing to show the whole model).

9. To center the view at a particular place, move the cursor there and press 
F.

At the current size and angle, the view changes to center on the 
selected point.

Adjust the 
Lighting

Mari comes with three lighting presets: flat, basic, or full. In basic and full 
modes, you can move the lights around the model.

1. To change the lighting:

• from the Shading menu, select Flat, Basic, or Full, or

• click , , or  on the toolbar.

TIP: If you find that the view starts cutting through the front clipping 
plane, try pressing A.

TIP: You can paint in any of the views.

Moving the view bakes the current paint if Bake Behavior is set to 
AutoBakeAndClear. You can set this on the Projection palette, under 
Projection (if you can't see the Projection palette, select View > Palettes 
> Projection to display it).

EXPERIMENT: Play around with zooming, panning, and rotating the 
camera. Try changing between Ortho and Perspective modes. Notice that 
objects closer to the camera distort far more than objects further away?
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Adjust the Lighting 
2. Notice the four lights in the viewport (you may need to select the Pan 

Object tool  to see them).

By default, the lights appear as gray spheres .

3. To move a light around, select the Pan Object tool  (if you didn't 

already). Click on a light and drag it around the viewport.

As you move the light, you can see the effect on the model.

4. You can also make fine adjustments to lighting using the Lights palette. 
If it's already open, click the Lights tab to give it focus; or if it's closed, 
right-click in the toolbar area on top of the Mari workspace and select 
Lights to open it.
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Adjust the Lighting 
The Lights palette displays details of four lights, which you can enable 
or disable, and customize by adjusting their Color and Fixed To informa-
tion — for details, see Chapter 2, “Customizing the view” in the Mari 
User Guide.

5. Lighting can be relative to the Scene or a Camera:

• Scene (default) — the light is fixed to the model, for example if a 
light is set at the model's back, it always points at the model's 
back, no matter how you move the view.

• Camera — the light is fixed to a camera view, for example you can 
have a light always shining from above the camera, allowing you to 
move the model around and cast light on different areas.

6. A single light can be moved to the position of the current camera by 
right-clicking the light and selecting Move to Camera Position or clicking 
on the Move to Camera Position icon when the desired light is selected.

7. To choose whether to Render Shadows for an individual light, select the 
checkbox.
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Where Do You Go from Here? 
Shadows render and display immediately for the selected light.

8. Shadows can be enabled or disabled in the display by toggling the 

Shadows  icon in the Lighting toolbar or the Shading menu.

Where Do You Go 
from Here?

At this point, you should have a basic idea of the different options for 
adjusting the view and lighting on your model. You learned how to:

• zoom, pan, and rotate

• choose one of six preset angles

• toggle split view

• change to flat, basic, or full lighting

• move and configure lights.

Now that you know how to create a project, load geometry, and adjust the 
position of the view and lighting, you can (finally) begin to paint! When 
you're ready, proceed to Tutorial 3: Painting!.

NOTE: Mari saves custom lighting with the project. If you need the same 
lights in another project, you need to set them up separately.
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About This 
Lesson 

What This Lesson 
Teaches You

This lesson teaches you the basic steps to painting on a model in Mari. This 
includes:

• selecting a brush

• selecting a color

• painting with that brush and color

What You Should 
Know Before 
Starting This Lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read the Mari Getting Started Guide up to this point

• that you know how to start Mari (see Launch Mari)

• that you have completed Tutorial 1: Setting up a Mari Project and 
Tutorial 2: Setting the View and Lighting.

Resources You Need 
to Complete This 
Lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample file:

• 1-Blacksmith — the Mari project file you created in Tutorial 1 and 
configured in Tutorial 2

How Long Should It 
Take? 

Plan on spending about 25 minutes to complete this lesson.
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About Painting in Mari 
About Painting 
in Mari

Painting in Mari is similar to painting in other standard paint programs — 
you can choose and configure both brushes and colors, and then use them 
to paint an object. In Mari, you configure brushes through the Brush Editor 
and colors through the Color Palette. You also have the option of saving 
colors and brushes to your Shelf for easy access. The Mari Shelf comes with 
lots of presets, as well as any items you have created or customized for 
yourself (and saved there).

After you paint (also as with other programs), in Mari you need to bake the 
paint buffer into the object. Mari includes various ways of baking onto 
selected patches, including an Autobake option that bakes by default every 
time you move the camera.

Steps for Painting in 
Mari

To paint in Mari, follow these steps:

1. Open Your Project

2. Open the Colors and Shelf Palettes

3. Select a Color

4. Select a Brush

5. Paint!

6. Bake Your Painting

Open Your 
Project

1. Start Mari (see Launch Mari). 

The Mari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open 
it.

Your project opens and switches to the Ortho view.

Open the Colors 
and Shelf 
Palettes

Basic painting on your model involves selecting a brush, selecting a color, 
and using them to paint. In the steps below, you'll select a color from the 
Colors palette and a brush from your Shelf. To begin, let's open and arrange 
those palettes.

1. To open the Colors palette:

TIP: By default, the Colors and Shelf palettes are already open when you 
start Mari (but follow the instructions below to see how to open and 
close palettes).
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Open the Colors and Shelf Palettes 
• from the View menu, select Palettes > Colors, or

• right-click in the toolbar area and select Colors from the dropdown 
menu.

The Colors palette displays.
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Open the Colors and Shelf Palettes 
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Select a Color 
2. To open the Shelf palette:

• from the View menu, select Palettes > Shelf, or

• right-click in the toolbar area and select Shelf from the dropdown 
menu.

The Shelf palette displays.

The shelf can hold your customized sets of colors and brushes — but 
when you first start Mari, the shelf is empty.

Select a Color 1. You can select a color from the Colors palette a few different ways:

• click in the color field

EXPERIMENT: The Mari Reference Guide outlines the different options for 
arranging palettes. Take a few minutes to experiment with docking, 
undocking, sizing, moving, collapsing, and stacking palettes (including the 
Colors palette and Shelf). Over time, you'll find a configuration that works 
best for you. And when you exit Mari, it remembers that configuration for 
the next time you re-start the program.
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Select a Color 
• click to select the H, S, or V next to the vertical sliders (to the right of 
the color field), then click and drag the sliders up or down to select 
color and alpha

• drag the horizontal sliders left or right, or type specific values in the 
boxes, to specify:

RGB( )or HSV( ),and Alpha( )

The selected color displays in the Foreground swatch (and in the swatch 
to the right of the vertical sliders).

2. When the color you want is selected in the Colors palette, drag the 
swatch to the Shelf.
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Select a Color 
You don't have to drag the color to the shelf to use it, but it's useful for 
storing colors you use regularly.

EXPERIMENT: Play around with all the different options for selecting 
colors. See if you can get these:

TIP: If you hover the mouse over a swatch, it displays RGB, HSV, and 
Alpha values:
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Select a Brush 
Select a Brush 1. To select a brush, open the Brush Editor palette:

• from the View menu, select Palettes > Brush Editor, or

• right-click in the toolbar area and select Brush Editor from the drop-
down menu.

The Brush Editor palette displays.

The Brush Editor has three tabs:

• Properties — configurable properties of the selected brush (see the 
Mari Reference Guide for details).

• Shelves — the same shelves that display in your Shelf palette.

• Presets — an array of predefined brushes that come with Mari.
Mari 2.0v1The Foundry



TUTORIAL 3: PAINTING! 78
Select a Brush 
2. Click the Presets tab. 

Three tabs display along the top for different sets of predefined 
brushes.

3. Click a brush to select it. 

TIP: At the bottom of the Brush Editor is a scratch area for you to test 
out the selected brush. You can press N to swap back to the last brush 
tip you used. This lets you quickly swap back and forth between two 
brush tips.

TIP: You can also customize brushes from the Brush Editor, and save 
them to the Shelf. This is covered in the Mari User Guide, but basically 
involves:

•   selecting a preset brush from the Presets tab

•   custom-configuring that brush by selecting options on the Properties 
tab

•   saving it by clicking the  button on the Shelves tab.
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Paint! 
Paint! 1. When you have selected a color and a brush (from the Colors palette, 
Brush Editor, and/or Shelf), you can use them to paint on the model. 
First select the paint tool:

• click  on the toolbar, or

• press P.
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Paint! 
2. Then paint!

TIP: You can undo and redo any action by pressing Ctrl+Z and Ctrl+Y, or 

clicking  and  on the Project toolbar, or selecting Undo and 

Redo from the Edit menu.

And, you can undo or redo multiple actions at once, by clicking on a 
specific action in the History View palette (from the View menu, select 
Palettes > History View).

The History View palette lists all actions you've performed since opening 
the project. There is no limit on the size of the action history, but it clears 
when you close the project.

Redoing an action in Mari only reverses a previously undone action. You 
cannot use the Redo command in Mari to repeat a command — it's 
reversing an Undo (not a “do that again”).
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Bake Your Painting 
Bake Your 
Painting

1. As with other paint programs, what you paint stays in a paint buffer 
until you “bake” it onto the model. To bake in Mari, make sure all 
patches with unbaked painting are selected, and then:

• from the Painting menu, select Bake, or 

• click  on the status bar, or 

• press B.

2. When you exit Mari, do not save the project. (We'll start the next lesson 
with the unpainted blacksmith you imported in Tutorial 1.)

Where Do You Go 
from Here?

This lesson covered the most basic options for painting in Mari:

• selecting a color in various ways, and dragging it to the Shelf

• selecting a brush from the Brush Editor

• painting on the model and baking.

The next tutorial, Tutorial 4: Painting Through and Clone Stamping, covers 
two main options for using images to create textures in Mari.

TIP: The Projection palette also includes a Bake Behavior option, which by 
default (AutoBakeAndClear), automatically bakes every time you adjust 
the view.
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About This 
Lesson

What This Lesson 
Teaches You

This lesson introduces using images to create textures in Mari. This 
includes:

• “painting through” an image onto your model

• “clone stamping” part of an image onto your model

What You Should 
Know Before 
Starting This Lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read the Mari Getting Started Guide up to this point

• that you know how to start Mari (see Launch Mari)

• that you have completed Tutorial 1: Setting up a Mari Project, Tutorial 2: 
Setting the View and Lighting, and Tutorial 3: Painting!

Resources You Need 
to Complete This 
Lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample files:

• 1-Blacksmith — the Mari project file you created in Tutorial 1 and used 
in Tutorial 2 and Tutorial 3

• Tattoo.png — an image of a tattoo, in your Mari tutorial directory

How Long Should It 
Take?

Plan on spending about 25 minutes to complete this lesson.
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About Painting from Images in Mari 
About Painting 
from Images in 
Mari

Like with other paint programs, Mari lets you superimpose image files onto 
the surface of an object. To manage image files, Mari includes the Image 
Manager palette. To paint with images you've loaded into the Image 
Manager palette, Mari has two main tools: Paint through and Clone stamp:

• The Paint through tool ( ) lets you position an image over an object, 

and then as you paint, copy from the image directly onto what's under 
the brush.

• The Clone stamp tool ( ) lets you position an image alongside an 

object, with a source point on the image relative to where the brush is on 
the object. Then as you paint, the source point on the image moves in 
sync with the brush on the object, and Mari copies from the image onto 
the corresponding spot under the brush on the object. 

You can also clone stamp from painting already on an object, in the paint 
buffer, or in another channel.

Steps for Painting 
Through and Clone 
Stamping

To paint through and clone stamp in Mari, follow these steps:

1. Open Your Project

2. Load an Image

3. Paint Through

4. Clone Stamp

Open Your 
Project

1. Start Mari (see Launch Mari). 

The Mari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open 
it.

Your project opens and switches to the Ortho view.
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Load an Image 
Load an Image For both painting through and clone stamping, we'll use an image of a 
tattoo that looks like this:

We'll start by loading that image in Mari's Image Manager palette.

1. To open the Image Manager:

• click the Image Manager tab if it is already open but hidden (as in the 
default Mari layout),

• from the View menu, select Palettes > Image Manager, or

• right-click in the toolbar area and select Image Manager from the 
dropdown menu. The Image Manager palette displays.
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Load an Image 
2. To load an image, click .

The Open an Image dialog box displays.

3. Navigate to your tutorial folder, and select Tattoo.png.

The tattoo.png image displays in the Image Manager.
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Paint Through 
Paint Through Painting through an image basically involves:

• selecting the Paint Through tool,

• dragging an image onto the canvas, and

• painting.

1. Select the Paint Through tool by:

• clicking  on the toolbar, or

• pressing U.

2. Drag the image from the Image Manager and drop it onto the model.

3. Move and resize the image:

• To resize the image, hold down Ctrl+Shift, click and drag.

• To move the image around the canvas, hold down Shift, click and drag.
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Paint Through 
• To rotate the image, hold down Ctrl, click and drag.

TIP: The Tool Properties palette includes many options for manipulating 
paint-through images.

You can also double-click the image in the Image Manager, and crop a 
smaller portion to use for painting through and clone stamping.
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Paint Through 
4. Paint through the image onto the model (hold down the left mouse 
button and move, as you do in any standard paint program).

5. When you're done painting through, press P to go to the Painting tool to 
see just the painted-on object.

EXPERIMENT: Try sizing, moving and rotating the image. See if you can 
get it to look like this:
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Clone Stamp 
Clone Stamp Clone stamping is like painting through, but the image does not have to sit 
directly on top of the model.

1. First, clear the painted-through textures:

• from the Painting menu, select Clear Painting, or

• click  on the toolbar.

This removes any un-baked painting on the model. In this case, the 
model re-displays as imported.

2. Select the Clone Stamp tool: click  on the toolbar. 

3. Drag the image from the Image Manager and drop it onto the canvas.

The image displays in a separate window.

4. Re-size and position the image window alongside your model. To scale 
the image within the window, hold down Alt, right-click and drag. To pan 
the image, hold down Alt, left-click and drag.

TIP: To hide the overlying image, press the ? (question mark) key. To paint 
the whole image onto the model in one step, press the ' (apostrophe) key. 
To repeat the source image (so you can paint past the edges and have the 
source image repeat), press the ; (semicolon) key.
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Clone Stamp 
5. To select the source point for cloning on the image, press Ctrl and click.

Once you start painting, a magenta + displays the source point on the 
image.

6. Once you've selected the source, you can paint. The cursor moves on the 
image in sync with the cursor on the model as it clone stamps from the 
image onto the model.
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Where Do You Go from Here? 
Where Do You Go 
from Here?

This lesson covered the two main options for painting images onto a model:

• dragging an image and positioning it on top of an object, then Painting 
through the image onto the surface of the object

• dragging an image and positioning it on the canvas next to an object, 
then Clone stamping from a part of the image to the surface of the 
object.

The next tutorial, Tutorial 5: Exporting and Importing, covers procedures 
for saving and re-importing your work.

TIP: You can also clone stamp from existing textures — painted on the 
surface of the object, in the paint buffer, or painted in another channel. 
To select a clone source, use the Source menu in the Project toolbar and 
select from the origins available.

EXPERIMENT: Change the view (as covered in Tutorial 2: Setting the View 
and Lighting), and try both painting through and clone stamping the 
image onto another side of the object. Do you like one method of using 
images to paint more than the other?
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About This 
Lesson

What This Lesson 
Teaches You

This lesson explains how you can export channels or layers you've painted 
in Mari as a set of image files, then re-import them into your project. This 
familiarizes you with just a few of the methods for exporting and importing.

What You Should 
Know Before 
Starting This Lesson

This lesson assumes:

• a basic knowledge of computers and graphics applications

• that you have read the Mari Getting Started Guide up to this point

• that you know how to start Mari (see Launch Mari)

• that you have completed tutorials 1 through 4 - so you know the basics 
of creating a Mari project, setting up the camera and lighting, and 
painting textures.

Resources You Need 
to Complete This 
Lesson

To complete this lesson, you need access to a computer that can run Mari, 
and the following sample files:

• 1-Blacksmith - the Mari project file you created in tutorial 1 and used in 
tutorial 2, tutorial 3, and tutorial 4.

How Long Should It 
Take? 

Plan on spending about 25 minutes to complete this lesson.

About Mari 
Exports

Mari includes the facility to export the painting in a project to a series of 
image files. You might use this, for example, to modify part of your work in 
an external program, and then re-import those modifications into the 
project. Mari lets you select formats and naming conventions for the 
export. Each export contains the painting baked in a selected channel, one 
image file per patch. When you import a series of previously exported files, 
Mari lets you know whether it's a complete set.
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Open Your Project 
Steps for Exporting 
and Importing

To export and import Mari painting, follow these steps:

1. Open Your Project

2. Export a Channel

3. Export a Layer

4. Import a Channel

5. Import a Layer

Open Your 
Project

1. Start Mari (see Launch Mari). 

The Mari workspace displays.

2. On the Projects tab, double-click on your 1-Blacksmith project to open 
it.

Your project opens and switches to the Ortho view.

Export a Channel 1. To export the current channel, Diffuse, from the Channels menu, select 
Export > Export Current Channel.

This exports the currently selected channel, Diffuse. To export any 
channel, right-click the channel you want to export in the Channels pal-
ette, and select Export > Export Current Channel from the dropdown 
menu.

The Export dialog box displays.
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Export a Channel 
2. If necessary, use the two left-hand navigation boxes to navigate to the 
folder you want to export to.

3. In the Template field, Mari names each image file in the export, one per 
layer and per patch, based on this template. The default is 
$CHANNEL.$LAYER.$UDIM.tif.

Notice the File Example below it, which displays what a filename looks 
like with that template. In the illustration, it's: diffuse.Base.1001.tif

So each filename includes the following (with examples from the illustra-
tion):

• $CHANNEL - the name of the channel you’re exporting layers from: Dif-
fuse.

• $LAYER - the name of the layers you’re exporting: Base.

• $UDIM - an incremental number identifying each patch in those layers: 
1001 (followed by 1002, 1003, and so on).

• tif - the extension for the selected file format. You can set the format 
for the exported files by changing this extension. Mari supports stan-
dard image formats (such as .tif, .exr, .png, .jpg, .tga, and .dds).

NOTE: For more information on UDIM number, please refer to the 
Working with Patches chapter in the Mari User Guide.
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Export a Layer 
4. Set the Use Template For field to determine if the template above is 
used for Only this layer (to only use the template for the layer displayed 
at the top of the dialog) or Everything (to apply the template to all 
layers in the stack).

5. Click Export All Patches.

This exports all patches. You may be notified that the selected directory 
does not exist, and prompted about whether you want to create the 
directory.

Export a Layer 1. To export selected layers, from the Layers menu, select Export > Export 
Selected Layers.

This exports any selected layers in the layer stack (in this case, Base). 
The Export dialog box displays.

TIP: The formats available to export depend on the color depth of the 
channel. Channels with color set to Half-Float or Float can only be 
exported to .exr, .psd, and .psb format. On Windows, channels with color 
set to Half-Float or Float also can be exported to .dds format.

NOTE: If Small Textures is enabled, Mari exports any patches that you 
haven't painted yet, or have painted as a single color, as 8x8-pixel 
textures. When you start to paint on a particular patch, Mari exports it 
as the correct size.

TIP: For a complete explanation of export fields, see the Mari Reference 
Guide and the Exporting and Importing Textures chapter in the Mari User 
Guide.
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Export a Layer 
2. If necessary, use the two left-hand navigation boxes to navigate to your 
tutorial folder.

3. In the Template field, Mari names each image file in the export, one per 
channel, layer and patch, based on this template. The default is 
$CHANNEL.$LAYER.$UDIM.tif.

Notice the File Example below it, which displays what a filename looks 
like with that template. In the illustration, it's: diffuse.Base.1001.tif

So each filename includes the following (with examples from the illustra-
tion):

• $CHANNEL - the name of the channel you’re exporting layers from: Dif-
fuse.

• $LAYER - the name of the layers you’re exporting: Base.

• $UDIM - an incremental number identifying each patch in those layers: 
1001 (followed by 1002, 1003, and so on).

• tif - the extension for the selected file format. You can set the format 
for the exported files by changing this extension. Mari supports stan-
dard image formats (such as .tif, .exr, .png, .jpg, .tga, and .dds).

TIP: The formats available to export depend on the color depth of the 
channel. Channels with color set to Half-Float or Float can only be 
exported to .exr, .psd, and .psb format. On Windows, channels with color 
set to Half-Float or Float also can be exported to .dds format.
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4. Set the Use Template For field to determine if the template above is 
used for Only this layer or Everything. If Only this layer is selected when 
attempting to export, Mari asks you for each individual layer whether 
you want to use the template. Setting the files to Everything can save 
time if you want all your selected layers to use the template.

5. Click Export All Patches.

This exports all patches.

NOTE: If Small Textures is enabled, Mari exports any patches that you 
haven't painted yet, or have painted as a single color, as 8x8-pixel 
textures. When you start to paint on a particular patch, Mari exports it 
as the correct size.

TIP: For a complete explanation of export fields, see the Mari Reference 
Guide and the Exporting and Importing Textures chapter in the Mari User 
Guide.
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Import a Channel 1. To import a channel (for example if you've tweaked some exported 
image files in another application and now want them back in your tex-
ture):

• from the Channels menu, select Import > Import into Layer Stack for 
the currently selected channel, or

• right-click on the channel where you want to import the textures (in 
this case, Color) in the Channels palette, and select Import > Import 
into Layer Stack from the dropdown menu.

The Import dialog box displays.

2. Select the path for the imported images, by either:

• typing it in the Path field at the top of the dialog,

• clicking on it in your directory bookmarks (to the left), or

• browsing to it in the middle panes.

If you are using the middle panes to browse to the directory, you can 
use the buttons above the view to navigate back, forward, up one direc-
tory level, create a new directory, or switch between icon-only and full-
details directory views.

3. Select the texture set to import.

Mari shows all the texture sets available under the selected directory, 
arranged by subdirectory.

For each texture set, the Import dialog box includes:

• Full - shows a green bar if the selected image sequence has a full set 
of images for the current model, a yellow bar if the selected image 
sequence has a partial set of images for the current model, or a red 
bar if the selected image sequence has no images for the current 
model. 
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• Images - the name of each image to import, with the UDIM number 
represented as @ (in this case, diffuse.@.tif) and frame number (if 
present) represented as #.

• Start and End - the first and last UDIM numbers in the image set (in 
this case, 1001 to 1055).

• Patch Count - the number of images in the set (in this case, 50).

4. In the Template field, Mari names each image file in the import, one per 
layer and patch, based on this template. The default is 
$CHANNEL.$LAYER.$UDIM.tif.

5. Click the Import All Patches to import the files into your project.

Mari imports the textures from the selected files.

Import a Layer 1. To import textures into a layer, from the Layers menu, select Import > 
Import into Layer.

This imports all selected textures into the current, selected layer (in this 
case, Base). The Import dialog box displays.

NOTE: Notice the File Example below the Template field, which displays 
what a filename looks like with that template. In the illustration, it's: 
diffuse.Base.@.tif

So each filename includes the following (with examples from the 
illustration):

• $CHANNEL - the name of the channel you’re importing: Diffuse.

• $LAYER - the name of the layers you’re importing: Base.

• $UDIM - an incremental number identifying each patch in those layers: 
1001 (followed by 1002, 1003, and so on).

• tif - the extension for the selected file format. You can set the format 
for the exported files by changing this extension. Mari supports stan-
dard image formats (such as .tif, .exr, .png, .jpg, .tga, and .dds).
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2. Select the path for the imported images, by either:

• typing it in the Path field at the top of the dialog,

• clicking on it in your directory bookmarks (to the left), or

• browsing to it in the middle panes.

If you are using the middle panes to browse to the directory, you can 
use the buttons above the view to navigate back, forward, up one direc-
tory level, create a new directory, or switch between icon-only and full-
details directory views.

3. Select the texture set to import.

Mari shows all the texture sets available under the selected directory, 
arranged by subdirectory.

For each texture set, the Import dialog box includes:

• Full - shows a green bar if the selected image sequence has a full set 
of images for the current model, a yellow bar if the selected image 
sequence has a partial set of images for the current model, or a red 
bar if the selected image sequence has no images for the current 
model. 

• Images - the name of each image to import, with the UDIM number 
represented as @ (in this case, diffuse.@.tif) and frame number (if 
present) represented as #.

• Start and End - the first and last UDIM numbers in the image set (in 
this case, 1001 to 1055).

• Patch Count - the number of images in the set (in this case, 50).
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4. In the Template field, Mari names each image file in the import, one per 
channel, layer and patch, based on this template. The default is 
$CHANNEL.$LAYER.$UDIM.tif.

5. Click Import All Patches.

This imports all patches.

Where Do You Go 
from Here?

This lesson showed you how to:

• export a current channel or selected layer in a Mari project to a series of 
image files.

• import textures into a channel’s layer stack or into a selected layer, for 
example after having manipulated the exported textures in another 
program.

Congratulations! You have now completed all modules in the Mari Tutorials. 
To better familiarize yourself with the features you are particularly 
interested in or to get answers to specific problems that arise during 
painting, please refer to the accompanying Mari User Guide and Mari 
Reference Guide.

NOTE: Notice the File Example below the Template field, which displays 
what a filename looks like with that template. In the illustration, it's: 
diffuse.Base.@.tif

So each filename includes the following (with examples from the 
illustration):

• $CHANNEL - the name of the channel you’re importing: Diffuse.

• $LAYER - the name of the layers you’re importing: Base.

• $UDIM - an incremental number identifying each patch in those layers: 
1001 (followed by 1002, 1003, and so on).

• tif - the extension for the selected file format. You can set the format 
for the exported files by changing this extension. Mari supports stan-
dard image formats (such as .tif, .exr, .png, .jpg, .tga, and .dds).

TIP: For a complete explanation of export fields, see the Mari Reference 
Guide and Exporting and Importing Textures chapter in Mari User Guide.
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